110833

Instruction
Manual

110834

Model #s: 110833/110834
Lit.#: 98-0917/02-07

Congratulations on your purchase of the Bushnell® 3.2 Megapixel ImageView™! Your
ImageView digital binocular is ideal for all sporting events and nature observation, as it
combines a high quality 8 power compact binocular with a versatile 3.2 megapixel digital
camera (with option for 4 MP effective resolution via software interpolation) which also
features video capability. Your Imageview has a “dual personality”, capable of taking high
resolution digital still photos as well as shooting video, with maximum recording time
limited only by the capacity of the memory card you use. The photos and videos are both
automatically stored in the internal memory, or on an optional SD (Secure Digital) card, and
can be instantly reviewed on the flip-up LCD, or downloaded to your computer without the
need to install any special software (With Windows 2000, XP, Vista or Mac OSX. A driver
is provided for Windows 98/98SE).
Before using your new ImageView, please read the instructions contained in this manual and
take time to familiarize yourself with the camera’s operation and many great features.
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Note: ImageView models 110833 and 110834 share identical specifications,
features, and operation. Only the body styling and appearance are different.
Model# 110833 is used for closeup illustration purposes in this manual.

QUICK GUIDE: BUSHNELL IMAGEVIEW 110833/110834
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Install
Batteries &
(optional)
SD Card

Insert 2 AAA batteries (see “Specifications”) into the battery compartment on the bottom of the camera pod
(Note polarity indication inside). An SD memory card (optional, use up to a 1 GB card) for increased photo
storage capacity may be installed in the card slot, located at the back of the camera pod (Insert card with label
side facing down, pushing lightly until it clicks into place. Push the card lightly in again to remove).

2

Turn On the
Camera

Raise the LCD display, pulling up at the indented areas on each side. Press and hold the POWER button
until the red power LED stays on, then let go. You will see a “Clock Set” screen when the camera is used for
the first time-refer to “Camera Setup” for details on setting the date and time, or press the Menu button with
“Cancel” still selected to set this later. Press “Display” to turn the LCD back on -you will see a “live” preview
of the image from the camera lens, located between the binocular objective lenses. You can also manually
turn the display off by pressing the Display button-it does not need to be on to take a photo. The entire
camera will automatically turn off after one minute (this can be changed using the “Auto Off” option in the
Setup menu) if it has been inactive (no buttons pressed). To turn power off manually, press and release the
POWER button. The default camera settings will provide optimum quality under most conditions.
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Format the
SD Card
(optional)

If you inserted an SD card earlier, format it before beginning to take photos if you are using it in the
ImageView for the first time. Press the View button below the LCD display. Press the Menu button in the
center of the silver keypad. Press the Down arrow key once to select “Format”. Note the warning that this
will erase all data on the card-make sure you have downloaded all photos from a previously used card. Press
the Right arrow key, to select “OK”. Press Menu to format the card (display shows “Formatting”). When the
display reads “No File”, press the View button to return to the live preview display mode.
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Set the
Binocular
Optics for
Your Eyes

Roll down the rubber eyecups if you are wearing glasses. Adjust the spacing between the left and right
binocular tubes while looking through the binocular until the view appears as a single circular image. Then,
find a distant object with fine detail, and adjust the center focus knob until the object appears sharp through
the left eyepiece . Now look through the right eyepiece only. If the object does not appear equally sharp,
rotate the right eyepiece (diopter adjustment) until it is also sharp. Once set, you no longer need to move
this diopter adjustment, and may simply focus using the center focus knob.
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QUICK GUIDE: BUSHNELL IMAGEVIEW 110833/110834
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Take A Photo
or Shoot A
Video Clip

Hold the camera steady with both hands and press the SNAP button to take a still photo. You will hear a
“beep” (this can be turned off), followed by a brief pause (“SNAP Processing..” displayed) as the camera
stores the photo in memory. To shoot a Normal video, press the right arrow key three times until the
movie camera icon appears at the top right corner of the display You can then start shooting the video
at any time by pressing SNAP. To stop recording video, press SNAP again.
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Review and
Delete Photos/
Videos

To review or playback a still photo or video, press the View button. You will see the most recent still
photo or video (first frame). To review previous photos or videos one at a time, press the Left arrow key.
The icon at the top right corner of the display will show the movie icon if the file is a video. The numbers
at the top left show the current file number/total files (2 of 3, etc). To play back a video, press the SNAP
button (press again to stop playback). To see “thumbnail” images of several stored photos/videos at
once, press the Right arrow key when the last photo you’ve taken is displayed. Use the Left/Right arrow
keys to select an individual file, then press Display to see it full frame. To delete photos/videos, press
Menu. Delete is the first option in the Review menu. Press Menu again, then select Delete One (only
the currently displayed photo/video) or Delete All,. Press menu, select (highlight) “OK”, then press
Menu again to delete the file.
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Connect To
A Computer
& Transfer
Photos

Before connecting the camera, install the driver from the CD-ROM if you use Windows 98/98SE, and
install PhotoSuite if you do not already have photo editing software. Connect the supplied USB cable
from the camera’s USB socket (on the back of the camera pod) to a USB port on your PC. If you have
Windows XP or Vista, just follow the onscreen directions/options that automatically appear. If you have
Win 98 or 2000, open “My Computer” on your PC. The camera is identified as a “Removable Disk”
-your photos are in the folders inside, simply drag them or copy/paste into any folder on your hard drive.
Refer to the “Transferring Photos” section of this manual.
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Technical Specifications
Magnification

8x

Still Photo File Size (Resolution)

2272x1760(4 MP via software interpolation),
2048x1536 (default setting), 1280x1024, 640x480

Objective Diameter

30mm

File Compression Ratio
(Quality)

1:50 (Best), 1:85 (Better), 1:95 (Standard)

Exit Pupil

3.75

Internal Memory

16MB Flash Memory (NAND)

Field of View

320 ft @ 1000 yds

Memory Expansion

Secure Digital Card , up to 1 GB capacity

Eye Relief

13mm

File Format (Still/Video)

JPEG/AVI

Lens Coating

Fully Coated

File Management

DCF (version 1.0), FAT 16 Format

Prism Type

Roof, BK-7 glass

LCD

1.5” TFT

Focusing Range
(binocular)

14’ ~ infinity

Video Resolution/Frame Rate

320x240 pixels per frame / 9 fps.

Weight

14.9 oz / 422 g

Color

24-bit color

Sensor Type

CMOS

Exposure Value Range

+/- 2 EV in 0.5 EV steps

Effective Pixels

3.2 Megapixels

White Balance Options

Auto, Daylight, Cloudy, Fluorescent, Tungsten

Shutter

Electronic, 1/16 to
1/1000 seconds

Menu Languages

English, French, Spanish, Italian, German, Chinese

Focusing Range
(camera)

Fixed, approx 30’ ~
infinity

Auto Power Off (after inactivity)

1, 2, or 3 minutes or Disabled per Setup menu

Lens Aperture

f/5.6

Power Supply

2xAAA Batteries, Alkaline/Lithium/NiMh type
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Camera and Binocular Parts Guide
LCD Display
Display
Button

Remote
Jack

Power
LED

USB
Port

View Button
5-way Keypad w/
Menu/OK Button
Diopter
Adjustment
Remote
SNAP

Binocular
Focus

MODE SNAP
Button Button
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Card
Slot

Pull Here to
Raise Display

Camera
Lens

LCD Preview Display Icons
4 3
1

5

2

Photo Preview Display

Additional Feature Icons
The 3 “additional feature”
icons appear next to the
memory icon (press the right
arrow key to cycle thru these,
press again after movie mode
to return to normal mode)
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#

Icon

1

Battery Indicator (low battery shown)

2

Resolution setting (Very High, High, Medium, Low)

3

Remaining Memory (fills in solid as internal or card memory is used)

4

# of Photos/Videos Taken

5

Quality/File Compression (***Best / **Better / *Standard )

6

Digital Zoom magnification (1.0x~3.0x. range 1.0x=no digital zoom)

7

Self Timer (10 sec snap delay)

8

Rapid Sequence (3 shot burst)

9

Video Mode (records until stopped or out of memory)

7

8

9

7

Loading Batteries
Turn the ImageView over, and slide open the battery cover as indicated by the arrow,
then tilt it up on its hinges. Insert 2 AAA Alkaline or Lithium batteries into the
compartment in the direction indicated by the diagrams inside, then tilt the cover
down again and slide it back into place until it clicks. Note: Rechargeable NiMh type
batteries may also be used, but some may not deliver adequate current to power the
ImageView. AAA NiMh batteries with a current rating of 850 mAh or higher are
recommended.

Tripod
Socket
Battery
Compartment
(Slide Open
In Direction
of Arrow)

Inserting An SD Card
The camera can store from about 15 (at 2272x1760 resolution and best quality) up to well over 300 photos in
the 16 MB internal memory, depending on resolution and quality settings (refer to the chart at the back of this
manual). To expand the available storage, you may add an optional SD (Secure Digital) memory card, with 1GB or
smaller capacity (256MB, 512MB etc). MMC cards, which look similar to SD cards, are not recommended. The
card is inserted into the slot on the back of the camera pod, with the “notched” corner on the left as indicated by
the card icon below the slot. Insert the SD card with the label side facing down. Note: be sure the power is turned off
before inserting or removing cards to prevent possible loss of files or damage to the card. A new card will not require
formatting, but a card that has been previously used in other devices (cameras, PDAs, etc) should be formatted by
the ImageView before beginning to take photos or videos (see the “Review Menu” section for how to do this). Note
that formatting will erase all files previously stored on the card, so be sure they have been downloaded or
copied first if you wish to keep them.
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Basic Binocular and Camera Setup
Before taking photos or videos, take a few moments to set up the ImageView for your individual eyesight and user preferences. Leave
the rubber eyecups in their “up” position if you are not wearing glasses, or roll them down if you are. Grasp the left and right sides
of the binocular, and pull them apart or push them together while looking through the binocular to adjust the eyepiece spacing until
your view is a single circular image. Find a distant object with fine detail (tree, sign, brick wall, etc), and adjust the center focus knob
until the object appears sharp when viewed through the left binocular eyepiece only. Then, looking at the same object through just the
right side of the binocular, simply rotate the right eyepiece until the image is equally sharp for your right eye. This is called the diopter
adjustment, and compensates for any difference in sight between your left and right eyes. Once set by following this initial procedure,
you may leave the diopter adjustment alone and just use the center focus knob to bring objects at any distance into sharp focus through
the binoculars (the minimum focus distance is about 15 feet).
Your digital photos and videos are not affected by the center focus knob, as the camera lens located between the binocular objective
lenses does not require focusing. It is preset so that objects ranging from approximately 50 feet to infinity will be in focus. Note that
the binocular is capable of focusing closer than the camera. Check the live preview image on the LCD display to make sure you are
far enough away to ensure sharp photos. The camera lens provides 8x magnification, which is the same as the binocular’s optics, and is
aligned so that and object centered in the binocular’s view will also be centered in your photos or videos. Therefore, it is not necessary
to have the LCD turned on or even raised while you are shooting photos or videos. Reducing use of the LCD will extend battery life
significantly.
You may want to go into the camera’s menu and set the correct date before using the camera for the first time. Raise the LCD display
and press the power button. After the startup display comes on, then goes out, press “Display” to turn the preview screen on. Press
Menu. Press the Down arrow key 5 times to highlight the “Setup” submenu, then press Menu again. Use the Down arrow key to select
“Clock Set”, and press Menu. Select “OK”, then press Menu again. Now set the Year, Month, Date, Hour, Minute and Second, using
the Up/Down arrow keys to make changes, and the Right key to move to the next item. Once date & time are set, press the Menu button. Press the Down arrow key twice to highlight “Date Stamp”, press Menu, then highlight your preference using the left/right keys:
Off (no date will imprint on your photo files), Year-Month-Day order, or Month-Day-Time order of appearance. Press Menu, then
keep pressing the down arrow key until you see “Exit” in the Setup submenu, press Menu, then go down to “Exit” in the main menu,
and press Menu again to return to the preview display.

9

Taking Still Photos
After following the initial setup as described in the previous pages, you are ready to take a photo:
1) Raise the LCD and press the Power button for 2-3 seconds (red LED lights, startup screen appears). Press the Display button to
turn on the LCD again if you want to see a preview of the image or check menu settings, battery condition, etc.
2) The ImageView will default to high resolution and quality settings, as well as “everything on automatic” when it is turned on for
the first time, so you can take excellent photos right away. If you prefer to use different settings, refer to the section “Using the Main
Menu” for directions regarding how to find and change settings such as resolution and exposure and other options.
3) You may compose your photo while looking through the binocular (the LCD does not need to be on to take a photo). However,
for the most accurate framing, checking the LCD preview is recommended.
4) Be sure you are not closer than approximately 50 feet from your subject. The binocular optics will focus closer than this, but the
camera focus is preset for best results with distant subjects (no focusing is necessary for the camera). The LCD may be used to verify
that the subject is not too close for sharp results.
5) Hold the camera as steady as possible with both hands and slowly squeeze the SNAP button. The display will go dark briefly
while the file is stored (“SNAP Processing..” is displayed), then you are ready to take another photo. The upper right corner of
the display will briefly show the number of the photo you have just taken. The “memory used” icon at the upper right corner of
the display will fill in as you use up the available internal or card memory. Once you are out, and the display indicates “Memory
Full” when SNAP is pressed, you are out of memory (storage space) and should download photos you wish to keep so they may be
deleted, or you may remove the filled up card and install another SD card.
6) Digital zoom up to 3x is available. Press the Down arrow key to zoom in (you will see the result on the LCD). Press the Up
arrow key to zoom back out. No digital zoom is used (optical magnification only) when “1.0” is indicated next to the magnifying
glass icon.
7) Press the View button if you wish to check the photo after you take it, then press it again to return to a live preview. See the section “Review Menu” for more regarding reviewing and deleting previously taken photos.
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Warning: Use care during handling to avoid touching the camera lens (located in the center between
binocular lenses) to prevent degrading the image quality. Clean the camera lens only with dry lens
tissue or microfiber cloth. DO NOT use liquids of any type.

Shooting Videos
(Setting/Using Video Mode)
1) Follow steps 1-4 on the previous page, “Taking Still Photos”
2) To change from still photo to video mode, press the Right arrow key 3 times, until the movie camera icon is displayed at the
top right area of the LCD. You are now in Video Mode. Press SNAP to start recording a new video clip, and press it again to
stop recording and store the video in memory. The recording time is limited only by the amount of internal or card memory
currently available. You may record a single long video until you run out of memory, or multiple shorter videos by stopping
and starting recording whenever you wish by pressing Snap. The counter on the upper left of the display shows the elapsed time
since the recording was started.
3) Press the View button if you wish to check a video after you shoot it. Press the SNAP button to begin playback, press it again
to stop playback. Press the Left arrow keys to review your previous video or still photo files. Pressing the Right arrow key after
the last video or photo is shown will display a “thumbnail” review of multiple files-use the arrow keys to highlight the file you
wish to review, then press Display to select and view it. When you are ready to return to the live preview display to shoot more
videos (or stills), press the View button.
4) See the section “Review Menu” for more regarding reviewing and deleting previously taken videos.
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Using The Main Menu and Setup Submenu

As mentioned earlier in this manual, your ImageView is already set for high resolution and quality right out of the
box. Exposure, white balance, and other variables are set automatically. This means that you will get good results for
most subjects and lighting without the need to go into the menus and change any settings. However, we recommend
that you become familiar with the available options so that you can improve your photos if, for example, you decide
they are coming out too dark (common for snow scenes with most cameras), or too green (under many fluorescent
lights). Press the “Menu” button to enter the main menu. Use down or up arrow buttons to highlight an option
within the menu, then press Menu if you wish to change the settings for that option. Use the Left/Right arrow to
select the setting you want, then press Menu to confirm this setting. The main, or camera, menu also contains a
submenu, called “Setup”, which contains the items you are most likely to need to set just once. Here are the options
and settings available in the main menu and its Setup submenu.
MENU

Option

Settings

Description

MAIN

EV

-2.0 ~ +2.0 (Default= 0
EV)

Provides manual under/over exposure adjustment
in 0.5 EV steps. Minus values produce darker
photos, plus values lighter.

Resolution

VH, H, M, L

Sets the desired still photo resolution in pixels.
Very High (2272x1760), High (2048x1536),
Medium (1280x1024), Low (640x480). Higher
resolution settings produce sharper/larger prints
but require more storage space in internal or
card memory. Use lower settings to store more in
memory, or for email, PC viewing only, etc.
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Main Menu continued
MENU

(Default Settings in Bold)

Option

Settings

Description

White Bal(ance)

Auto, Daylight, Cloudy, Sets the reference for neutral white, so that colors
Fluorescent, Tungsten
are reproduced correctly. If “Auto” does not
provide good results, try the setting that matches
the light source.

Meter

Multi, Spot, Center

Sets what area of the framed subject is used
to determine exposure. “Multi” uses multiple
zones, “Spot” uses only the center area (good for
strong backlit situations), and “Center” bases the
exposure 60% on the center of the frame, 40% on
the rest of the frame.

Image Quality

Standard, Better, Best

Sets the amount of file compression, which affects
the quality of the photo and the size of the file
it creates. This can be used independently of
Image Size to help store more photos in exchange
for slightly reduced quality. “Best” produces the
highest quality, but also generates larger files
that fill available memory sooner (fewer photos
possible).
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Main Menu continued
SETUP
Submenu
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(Default Settings in Bold)

Options

Settings

Description

Language

English, French, Span- Selects preferred language for all menu display
ish, Italian, German, screens
Chinese

Auto Off

Disable, 1 min, 2 min, Sets the interval after the last action (pressing any
3 min
button) before the camera turns off to conserve
battery power. Select “Disable” to prevent auto
shutoff altogether.

Clock Set

(Cancel, OK)

Select “OK” and use the arrow keys to set (in order) the Year, Month, Date, and Hour, Minute,
Second. See “Date Stamp” also

Sound

On, Off

Turns the confirmation beep sound on or off

Date Stamp

Off, YY-MM-DD, MMDD-TT

Off:Date and Time are not added to the photo
files. YY-MM-DD: Year/Month/Date are added
to each file. MM-DD-TT: Month, Date and
Time are added to each file

60Hz/50Hz Set

60 Hz, 50 Hz

Set to the AC line frequency for your country.
Affects primarily videos shot under fluorescent
lighting.

Main Menu continued
MENU

Option
Exit

EXIT

(Default Settings in Bold)
Settings

Description
Select “Exit” and press Menu to exit the Setup
submenu.
Select “Exit” and press Menu to exit the Main
menu and return to the preview (“live” camera)
display
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Additional Features Menu
Additional Features (Press the Right Arrow Key during regular preview display)
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Feature

Icon

Description

Self Timer

Clock

Photo taken after a 10 second delay when Snap button is
pressed. With the ImageView mounted on a tripod, this can
help prevent blur caused by jarring the camera when Snap
is pressed. To take a photo at the exact time you wish and
reduce camera shake, plug the included remote shutter release
cable into the jack on the rear of the camera pod and press the
button on the remote instead of Snap on the camera.

Sequence

Multiple Frames

3 frames taken in rapid sequence when Snap is pressed

Normal
Video

Movie Camera

Camera shoots video clip when Snap is pressed, with
maximum recording time limited only by the amount of
available internal or card memory. The counter in the upper
left corner displays elapsed minutes and seconds. Press Snap
to stop recording.

Review Display Indications
# Icon
1

Current file number (left numeral) : Total files in memory (right numeral)

2

Resolution of current review file

3

Date of photo or video file (Date feature must be setup and turned on)

1

2

3

Review Menu

Reviewing and Deleting Your Photos and Videos
Press “View” to enter Review mode. Use the Left arrow key to go back through the stored photos/videos. Once
you are in review mode, pressing the Menu button will enter the review menu. This operates in the same way
previously described in the main menu system instructions (use the arrow keypad to navigate to the desired menu
option and settings, press Menu to confirm a setting), but with different menu items as shown in the following
table:
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Review Menu continued
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Option

Settings

Description

Delete

Delete One, Delete All,
Cancel

Deletes all stored files. To delete all files, (except protected-see
below) highlight the “Delete All” icon and press “OK”. Then
highlight “Yes” and press “OK” to delete all files currently in
memory.

Format

Cancel, OK

Select OK and press Menu to format (clear) an SD card for
use in the camera. Erases all previously stored files on the
card. Will also erase internal memory contents.

Protect

Press “Menu” to protect
the currently displayed
image

Protecting a photo or video file prevents accidental erasure.
Can be used together with “Delete All” to quickly delete all
but one or two photos by protecting them first. Press “Menu”
again when a previously protected photo is selected to unprotect it. Note: Formatting internal or card memory will erase
even protected files.

Setup

Same options and settings are available as listed in the Main
Menu

Exit

Exits the review menu and returns to the last selected review
image.

System Requirements (Minimum)

OS: Windows® 98/98SE/2000/ME/XP/Vista (see note under “Software Installation” regarding Vista)
CPU: MMX Pentium® 200MHZ equivalent or faster (Pentium® III 500 MHz for PhotoSuite5™)
Memory: 32MB minimum (64MB recommended for PhotoSuite)
SVGA video card w/2MB VRAM, 800x600 screen display, 16 bit High color
200 MB available hard disk space (if installing PhotoSuite)
Internal USB Port

Software Installation

If you are using Windows 98, you must install drivers before connecting the camera to your PC. Insert the CD-ROM
into your computer’s CD drive; it will auto-run and the install screen will be displayed. Select “Install Driver”, then
follow the directions. After installation, restart your computer. Windows 2000, ME, XP and Vista do not require
drivers, as the camera uses the USB mass storage standard , allowing the photo files to be accessed as if they were
stored on an external hard drive. For any Windows OS, if you are not already using photo editing software you prefer,
you may install Roxio PhotoSuite® from the CD-ROM. Note: With Windows Vista, you may encounter error or warning messages (“file missing”, etc) while installing PhotoSuite 5, but clicking “OK” and proceeding should allow installation
to complete. Be sure to read the “Release Notes” completely, noting any tips or potential issues relevant to your PC
configuration and OS.

Transferring The Photos & Videos to Your PC - Step by Step

1. Be sure the driver has been installed first if you are on Windows 98/98SE.
2. Connect the supplied cable to the ImageView’s USB port, then directly to a main USB port on your computer-do
not use front panel/keyboard USB ports or unpowered “hubs”.
3. The LCD display will indicate “Mass Storage”, and the ImageView will be recognized as a standard “USB Mass
Storage” device. This means that the camera files can be easily viewed, edited, or copied to your hard drive, just as if
they were stored on an external hard drive or a CD-ROM.
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Transferring The Photos & Videos to Your PC

continued

4. (This step is not required with Windows XP, simply use the options in the pop-up window to view, copy or edit your
photos). Open My Computer or Windows Explorer. The camera will be seen as a new “Removable Disk” with an
unused drive letter assigned to it. Double click this new “Disk” icon, open the “DCIM” folder inside, then the
folder(s) inside that (“100MEDIA” ,etc). Your photos/videos are the files inside-they have the prefix “IMG__”
followed by a number, same as seen earlier on the camera’s display when you review photos. Single clicking any file
should show a small preview image.
5. Click “Edit>Select All” (or click on one photo, contol+click to select multiple photos), then “Edit>Copy to
Folder” (in Windows menus). Select an existing folder on your hard drive, such as “My Pictures”, or create a new
folder (“Hawaii Vacation”, etc), then click “OK” to transfer copies of the photo files you want.
6. After the photos are transferred to your hard drive, you can disconnect the camera. Windows 2000 may produce
a screen warning that you have disconnected a USB device without stopping or ejecting the “disk” first (your
photo files will not be harmed). If so, check the box that adds an icon to your system tray or taskbar. Then next
time you finish transferring photos, you can click that icon first, and “Stop the USB Mass Storage Device” before
disconnecting the camera. (On Mac computers, you should “eject” the “disk” that appeared on your desktop when the
camera was connected.)
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Note: If your PC will not play the .avi movie files in Windows Media Player, you may need to
download a newer version of Media Player or Direct X from Microsoft.com. The movie files can also
be played back with the QuickTime Player, included with many computers, or available as a free
download from Apple.com.

Transferring The Photos & Videos to Your PC continued
7. You’re now ready to open the photo files in any photo editing software. Just use File>Open and go to the folder
where you stored the photos earlier. If you are using PhotoSuite, select File>Open Photo, then use the “Look in”
pull down menu at the top of the Open window, select “My Computer”, select your hard drive, and double click
any photo in the folder where you copied the files from the camera. It is also possible to open and work with your
photos directly from the ImageView while it is still connected.To do this with PhotoSuite, first follow steps 1-3,
then open PhotoSuite, select File>Open Photo and use the “Look in” menu to select My Computer, then select
the “Removable Disk”, and open the folders inside until you get to the JPEG photo files. If you choose to work
this way, from a connected camera, be sure that you save the photo (when you are done editing) to your hard drive,
and not the camera’s memory or card. To do this in PhotoSuite, after clicking “Done”, answer “Save Changes?”
with “Yes”, but then answer “Replace Existing File”? with “No” and use the “Save As” dialog box to save the edited
photo in a folder on your hard drive (“Save In>Local Disk”), not the “Removable Disk” (camera).
8. If you are new to photo editing on a computer, consult your software’s Help menu (PhotoSuite has extensive
built-in Help) for tips on using its features. Along with adjusting the brightness, contrast, sharpness and color
of your photos, you can resize the photo to fit the paper if you are printing, or save a smaller, low or medium
resolution version for email or inserting into documents. When you are ready to save your edited file, you may
want to use “Save As” and give it a more descriptive name than “IMG___”. Doing this also preserves the original
file as a backup to reopen and re-edit later. Make sure you have successfully transferred all the photos you wanted
to save before using “Delete All” on your camera to make room for new images.
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Photo Storage Capacity Reference (avg. capacity for settings, +/- 5 photos)

Notes

Image Size

Megapixels
(approx)

Quality 1

Internal
Memory 2

64 MB SD
Card

VH 2232x1760

4.1 (Interpolated)

Best

15 photos

60 photos

Selects amount of file
compression
***: Best Quality (minimum
compression)
**: Better Quality (medium
compression)
*: Standard Quality
(maximum compression)

Better

17

68

2

Standard

22

88

Best

33

132

Better

38

152

Standard

49

196

Best

101

404

Better

115

460

Standard

150

600

Best

283

1132

Better

323

1292

Standard

419

1676

H 2048x1536

M 1280x1024

L 640x480
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1

3.2

1.5

0.35 (“VGA”)

Internal RAM available for
photo files: 16 MB
Image Size refers to the pixel
dimensions, or resolution, of the
digital file.
Actual storage capacity will vary
based on content of each photo
file. You may be able to take a few
photos more or less than the listed
average capacity.
Use High or Very High resolution
and Best quality settings for
photos you may want to enlarge
or crop later. If required, they can
always be reduced to a smaller file
size using your photo software.
Use Low or Medium and/or lower
quality settings if you will only
email, insert into documents, or
make small prints, and do not
want to resize the file later.

TWO-Year LIMITED WARRANTY
Your Bushnell product is warranted to be free of defects in materials and workmanship for two years after
the date of purchase. In the event of a defect under this warranty, we will, at our option, repair or replace
the product, provided that you return the product postage prepaid. This warranty does not cover damages
caused by misuse, improper handling, installation, or maintenance provided by someone other than a Bushnell
Authorized Service Department.
®

Any return made under this warranty must be accompanied by the items listed below:
1)
2)
3)
4)
5)

A check/money order in the amount of $10.00 to cover the cost of postage and handling
Name and address for product return
An explanation of the defect
Proof of Date Purchased
Product should be well packed in a sturdy outside shipping carton, to prevent
damage in transit, with return postage prepaid to the address listed below:

IN U.S.A. Send To: 		
Bushnell Outdoor Products
Attn.: Repairs		
8500 Marshall Drive		
Lenexa, Kansas 66214

IN CANADA Send To:
Bushnell Outdoor Products
Attn.: Repairs
25A East Pearce Street, Unit 1
Richmond Hill, Ontario L4B 2M9

For products purchased outside the United States or Canada please contact your local dealer for applicable
warranty information. In Europe you may also contact Bushnell at:
					
BUSHNELL Performance Optics Gmbh
					
European Service Centre
					
MORSESTRASSE 4
					
D- 50769 KÖLN
					
GERMANY
					
Tél: +49 (0) 221 709 939 3
					
Fax: +49 (0) 221 709 939 8
This warranty gives you specific legal rights.
You may have other rights which vary from country to country.
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FCC Note:
This equipment has been tested and found to comply
with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful
interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy
and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio
communications. However, there is no guarantee that
interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio
or television reception, which can be determined by
turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the
following measures:
· Reorient or relocate the receiving antenna.
· Increase the separation between the equipment and receiver.
· Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.
· Consult the dealer or an experienced radio/TV
technician for help.
The shielded interface cable must be used with the
equipment in order to comply with the limits for a digital
device pursuant to Subpart B of Part 15 of FCC Rules.

Specifications and designs are subject to change
without any notice or obligation on the part of the
manufacturer.

Notes

INNOVATION THAT THRIVES OUTSIDE

For further questions or additional information please contact:
Bushnell Outdoor Products
9200 Cody, Overland Park, Kansas 66214
(800) 423-3537 • www.bushnell.com
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